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Introduction

This guide will help you plan, design and execute efficient load testing using WebLOAD.

It will help you:
Understand the Plan and implement
methodology and your load testing efforts
essential steps for with WebLOAD in the
conducting load testing. most efficient way.

If you are totally new to load testing | suggest that you read the 2 following resources below:

>> What is load testing? A primer.

>> 4 types of load testing and when each should be used.
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http://www.radview.com/blog/what-is-load-testing/
http://www.radview.com/blog/4-types-of-load-testing-and-when-each-should-be-used/

WebLOAD Components and Architecture

WebLOAD's key components include: O=wp

B Integrated Development Environment (IDE) B Analytics - for analyzing test results.

- for developing load scenarios. . B ControlPad - the WebLOAD ControlPad
B Console - for managing and controlling tests. provides a single unified command and

B Load Generator - for generating load on your system. control interface where you can create,

execute, schedule, and analyze tests - all
directly from your web browser.
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WebLOAD Components and Architecture

B WebLOAD IDE

You create your scenario/script - called Agenda in WebLOAD - via the WebLOAD IDE recorder, or directly script it using
WebLOAD IDE editor. Using the IDE, you can define correlations, validations and parameterization, and define special
parameters that affect the behavior of your scenarios. If these concepts are new to you, don't worry, they are all clarified
later on in this document.

When you save your Agenda it is saved as a WebLOAD Project File (.wlp). It is recommended to test your created Agenda
in WebLOAD IDE prior to the real load test. If you save your Agenda after you run it in the WebLOAD IDE it will be saved
in WebLOAD Session file (.wls). While the .wlp file contains the agenda including all the recording information, the .wls
includes all the recording and execution information that is gathered by WebLOAD IDE during the execution of the
Agenda.

B WebLOAD Console

Using the WebLOAD Console you define the test to be executed by defining a Template (.tpl). A template, which
represents a whole test, defines:

B The agendas to be executed.

B The number of virtual users to be used on a specific schedule.

B The Load Generators (LG) machines and cloud LG machines.

B Probing Client machines.

B Performance Measurements of your servers to be collected during your test.

Once the test execution is completed, you can save the test results into a load session file (.Is).
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WebLOAD Components and Architecture

B Load Generator (LG)

The load generators are machines that create the load
on your system. Each load generator can run thousands
of virtual users, and WebLOAD lets you define many
load generators per each test, so you can easily reach
hundreds of thousands of virtual users in a single test.

TIP ' The console itself also contains a load generator,
but it is recommended to have separate load generator
machines for large scale load tests. You can use the LG on
WebLOAD Console for small scale tests and for validating
the tests before large scale tests.

Probing Client

The probing client is a concept of running a single virtual
client on a single and dedicated machine throughout
the load session. The idea is to see how the load affects
a standalone virtual client that is not related to the load
overhead.

WebLOAD Analytics

While the WebLOAD Console lets you see test results
during and after the test execution, WebLOAD Analytics
lets you analyze test results in depth and create reports.
WebLOAD Analytics is a comprehensive reporting
framework offering many predefined and configurable
charts and reports, which can be emailed or printed.

B WebLOAD ControlPad

The WebLOAD ControlPad is a lightweight web server
that lets you create, execute, schedule and analyze
tests. You can view data from a browser or a mobile
device, share results/views with your peers, and create
your own views of the data.

PostgreSQL DB

WebLOAD session results are saved in files (.Is). These
files are used by the console to view test results.
WebLOAD Analytics and WebLOAD ControlPad use the
PostgreSQL DB to view test results. After or during the
test, test results are pushed to the DB, so that they can
be viewed by WebLOAD Analytics and the WebLOAD
ControlPad.

TestTalk

TestTalk is an internal component to WebLOAD which
is responsible for the internal communication between
all WebLOAD components. It must run on any machine
that runs a WebLOAD component.
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WebLOAD Deployment

A typical WebLOAD deployment consists of the
following:

H WebLOAD Console
One or more machines that can coordinate a test, which
should be installed on a Windows machine. WebLOAD
IDE, LG, and WebLOAD Analytics are part of the console
installation.

B Load Generator and probing client

machines

The number of Load Generators is not limited, and will
depend on your needs. The load generator machine can
be installed on a Windows or Linux machine, on premise
or on the cloud.

TIP ‘& There are also pre-installed Load Generators on
AWS cloud. If you have an Amazon account, WebLOAD can
start LG machine on Amazon automatically for you during
test initiation. It also stops the machine when the test
ends.

B Test Talk
TestTalk is WebLOAD's internal communication
component. It is installed with all other components and
uses ports 9000 and 9010 by default. Make sure that no
other application is using these ports, or that the firewall
is not blocking these ports. TestTalk ports can be changed
via configuration file (WebLOAD.ini).

TIP & It is recommended to run TestTalk as a service on

Windows or as a daemon on Linux. You can apply the
option during installation. Note that TestTalk service
requires administrator rights.

PostgreSQL DB

WebLOAD Installs the PostgreSQL DB as part of the
WebLOAD Console installation. This provides the ability
to work on the same machine with WebLOAD Console,
WebLOAD Analytics and WebLOAD ControlPad.

You can also work in a distributed mode, where you
install several WebLOAD consoles, WebLOAD Analytics
and the WebLOAD ControlPad on different machines.
In this case you may prefer to have a centralized
PostgreSQL DB installation, with all WebLOAD
components connected to it. This can be configured via
the following settings:

WebLOAD Console Global
- Tools Options > Database
WebLOAD Analytics
- Window ytl > Preferences > Database

WebLOAD ControlPad - Attaching to the
PostgreSQL DB is done via dashboard.bat
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WebLOAD Deployment

B WebLOAD ControlPad
The WebLOAD ControlPad is typically installed as part The following diagram illustrates example of distributed
of the console machine but it can also be deployed deployment of WebLOAD:
on a dedicated machine. The WebLOAD ControlPad is
automatically attached to the local PostgreSQL.

In order to show currently running sessions - In
WebLOAD Console, go to

.. Load Generators
WebLOAD Distributed & Probing Clients

- Depl Exampl
Tools > Global options » Database eployment Example

ControlPad

and set the checkbox ‘Insert Statistics into

PostgreSQL database during the session’.
5 . fg— |

IDE | Console | Analytics

E |
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RADVIEW

“—



Planning Your Tests

Before you get into your car, you always know where you're going. The same applies in load testing.
Planning is critical and prior to creating any test, you should ask yourself:

pnoe |
en
you want to For how W;efassggceems/\s or
simulate? long? Pailure?

All of these and more must be clear ahead of time. Otherwise, you'll find yourself running around in circles
without making any real progress.

A full blown book can be written on planning load testing but here are a few essential guidelines:
B Building Testing Environment

Build a testing environment that simulates your real life environment. For more information, see this blog post: http://www.
radview.com/6-tips-for-building-a-better-load-testing-environment/.

TIP ‘& Do not forget to simulate any periodical/background processes in your real environment. They may affect your users
while they are running.

TIP '@ You may need to disable some features in your application. For example, if you have integration with a payment
system, you do not want your test to make a payment. Or if you simulate book ordering, you do not want items to be

shipped to virtual users!
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Planning Your Tests

B Scenarios Planning

Plan for your users’ scenarios. Make sure you cover the
following questions:

A. How many users are working in parallel?

B. Which scenarios are they running? What is the
distribution of the scenarios between the users?

C. From which locations? What is the distribution of the
scenarios between locations?

D. Which device are your users using? In which
distribution?

E. Whatis the expected load during peak times? For
example, a certain day like Black Friday. Another
example may be stock buy/sell requests that may
be higher at the beginning of day, or week. In other
words, when you plan your test schedule, it should
be based on the behavior of your system in real life.

For more information about planning and creating
scenarios see: http://www.radview.com/how-to-plan-
realistic-load-test-scenarios/.

B Defining Success Criteria

Define success criteria that will be based on:

A. Successful transaction percentage

B. Expected response time

C. Expected response validation errors percentage

You may have different success percentages for different
transactions from different locations.

B Uptime Planning

Test duration. How much uninterrupted uptime does your
system require? This affects how long your test should run.
For example, if you have an online store that needs to work
24/7, it may be smart to test it for a few weeks to ensure
response time or memory usage does not deteriorate
during long runs.

B Full Test vs. Component Test

You may decide to test your system in several ways:

A. Testing the entire system from the cloud - this will
ensure that you are addressing all layers: the internet,
load balancer, web servers, web apps, etc.

B. Testing the system from your internal network,
skipping the internet. You can even skip the load
balancer and test your system starting from your web
server.

C. Test specific layers inside your system, for example
web services or even a specific DB query.

RADVIEW
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Building Agenda Using WebLOAD IDE

Use the WebLOAD IDE to create Agendas to be later executed by the WebLOAD Console.
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B Record

The most common usage is to record your agendas WebLOAD records your activity in “Incognito mode” in
using WebLOAD proxy recorder. When you click the Chrome (“In-Private” in IE), which means that your cache
record button, you can select which browser to use for and cookies are ignored. In this situation your activity is
the recording, and you can also identify your session as recorded as a new user who is doing an activity.

it was done by a browser or by a mobile device. TIP ‘& HTTP traffic is being recorded by WebLOAD's

proxy, using the default port 9884. If this port is used by
another process, change it via

Recording and Script Proxy
Tools > Generation Options > Options

@ Tips

B Begin/End Transaction. Transaction is an
important term in load testing, as it represents
a certain activity that you might want to measure, for
example, "login”, “buy stock”, etc. That activity can be
built from one HTTP request, or a few HTTP requests
or others. You might want to wrap the relevant HTTP

requests with Begin/End Transaction.

B Filtering. The proxy recorder records all the traffic that
goes from the browser. There are redundant URLs that
you may want to filter out from your test. For example,
there are ads that are directed to an external site, or a

Make sure that a small toolbar named WebLOAD browser plug-in that performs some activity. WebLOAD
Recording is opened automatically where you can control can filter these activities from the recorded session.
the recording, add “transactions”, add “messages”, etc. Go to
Recording and Script URL
Joes > Generation Options > Filtering
RADVIEW )
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B Script Manipulation
Agenda Tree Pane and JavaScript View Q

You can see the recorded agendas via 2 main views:

B Tree Pane on the left
B JavaScript View on the right

These 2 views are correlated. Clicking on a specific node on
the tree will present the node related script on the JavaScript
View to be edited. Clicking on the tree root will present the
entire JavaScript code. To edit the entire script, press the “full
script” button.

TIP ¥ WebLOAD IDE has two working modes: edit mode
and execution mode. When you are in execution mode, you
cannot make any change to your Agenda as it affects the
execution. So, before executing, WebLOAD asks you to save
all your work and it moves you automatically to execution
mode. If you want to edit your Agenda, switch back to edit
mode.

TIP ‘& Right click in your script to easily insert WebLOAD
variables and methods to your script.

TIP '@ for advanced users: WebLOAD has special
methods such as InitAgenda that runs once for each
execution, or InitClient that runs once per each client,
etc. You can create these methods by selecting these
Functions at the top of the JavaScript View, and write
your JavaScript special code. To learn more about
WebLOAD methods flow, it is recommended to drill
down into the documentation.

Toolbox Pane

To manipulate the JavaScript code, you can also use the
toolbox on the left panel. Just drag and drop a certain
building block to the tree. Once you're done, new node
will be added to the tree. The most useful building
blocks are the Begin/End Transaction and Set/Send
timer. All building blocks are also available in direct
scripting.

RADVIEW)

‘/



Advanced Scripting - JavaScript, DOM, XML, & Java

WebLOAD uses the Standard JavaScript Language with many dedicated objects and methods that help create tests - starting
with Objects such as wlHttp, wiFTP and other protocols, wiGlobals for setting global variables, special methods for Messages
such as InfoMessage and ErrorMessage, Transaction Methods, etc.

WebLOAD also creates DOM for each Http response, which provides many capabilities to manipulate your response by
scripting special verifications, etc.

You also have direct access from JavaScript to Java, COM, and XML Objects. This lets you call external code, and enhance your
script with non-standard APIs and protocols.

@ Tips

B Itis recommended to go over the WebLOAD Scripting Guide dog, in
order to learn more about these scripting methods and many more.

B In order to code in your script, you can add a code to any recorded
node, but it may be convenient also to drag and drop JavaScriptObject
to the tree, and you can code there anything you'd like. This way you
can keep the structure of the tree while adding the JavaScript segment
you need.

B You can save your reused JavaScript methods in a .js file, and when
needed use the IncludeFile method. A good example for such a
usage may be login and logout which are common to all application
activities.
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B Correlation

Correlation is an important concept in Load Testing. It
addresses the ‘conflict’ between the fact that servers keep
track of client sessions and add dynamic values to the client's
sessions on one hand, and the fact that these dynamic values
become static in a recorded script on the other hand. The
script needs to be changed in order to get rid of these values
and make the script dynamic values ‘friendly’. A good example
of this is SessionID, which is unique to every client. It cannot
use the recorded SessionID. Doing so will cause errors.

WebLOAD's correlation engine helps you find the ‘problematic’
values within the recorded script and replaces them
automatically. The correlation uses a rule based engine that
has default rules, and can be enhanced with any new rule

that you find necessary. Once the rules are set correctly, you
do not need to deal with the dynamic values ever, since after
WebLOAD learns your application, the entire process is 100%
automatic.

Once the agenda recording is done, a correlation window

will be opened. If it is the first time you have recorded your
application, click on the button “Automatically discover rules
and correlate script”.
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This will open a screen with all fields which are suspected as TIP & WebLOAD helps you define the
dynamic values that need to be correlated. Now, you can mark necessary rules for future recordings. It

which rule should be used. shows for each value whether it was found
by a predefined and Active rule. WebLOAD
also shows whether a value was found by its
enhanced automatic algorithm that scans
the pages and looks for more sophisticated
values - these values are presented as
Temporary. If you find a temporary rule as
one that should work for future recordings
as well, make it Permanent via the
dropdown menu.

TIP & Many times, servers have a time
related dynamic value. If you execute the
script right after the recording (without
correlating), it might execute correctly, but
after an hour when the server changes
the dynamic value, your script will fail.

It is a good practice to test your script
after correlation, to make sure the value
replacements are done correctly. It is even
better to test your script again a few hours
later, or even a day after it was recorded and
edited, to make sure it still works correctly.
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H Parameterization

Parameters are your way to create real life
scenarios. For example, you would like to create
a load test with 1000 different virtual users at
the same time. You'll need to create different
login details - username and password - for
every virtual user. Not using parameters may
cause errors in the best case or an inaccurate
test in the worst case.

The Parameterization Manager on the home tab
menu helps you manage your parameters. You
can get parameters from a predefined file, or
create dynamically dates, times, strings, etc.

Once your parameter is configured, it will be
automatically added to a WebLOAD variables list
and you are able to use it in your script view via

“right click” > Insert Variable

similar to the way you add any other WebLOAD
variable to your script. You can always code it
directly as well.
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B Response Validation

In load testing it is important to validate the correctness of the responses and not just keep track of performance. This
ensures that the server is functioning correctly, even under load. For more details, read the blogpost:

www.radview.com/blog/validation-during-load-testing-trust-but-verify/

WebLOAD lets you verify response values by coding validations directly in the script or by using the Response Validation
feature. When you are focused on a certain node, working in Page View or HTML View of each node, you can right click and
open the response validation window. You can then define validation for a certain value in the page, set a time limit to the
page, decide how to proceed when validation fails, etc.

TIP ‘& You can combine the response validation and
the parameterization manager. As part of validating
response values in your script, you can have a
predefined list of known values that you expect to

see in the response. For example, if you have 1000
different users for your bank application, each will have
a different balance you may want to validate.
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B Testing Your Script

After you have made all necessary changes to your script, it is highly recommended that you
will execute the script several times to make sure it works properly. You may have made many

changes while developing the script, so before you load test your system with 10,000 virtual
users, you want to ensure it performs correctly.

In WebLOAD IDE you can run the script from start to end directly or you can use the Debugger

which lets you run the script step by step, set breakpoints, check each step, check temporary
values you have set, etc.

TIP ' When you run your script you can see side by side and compare the server
response during current execution and during the recording phase.
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Executing an Agenda Using

the WebLOAD Console

The WebLOAD Console lets you manage load testing execution by choosing the agendas, the load
generation machines, the load profile (virtual users throughout the test), etc.

Before defining test execution parameters, bear in mind your test goals and requirements. How many virtual users, which
activities, in which percentages, from which locations, etc. In addition, server performance measurement that you would like

WebLOAD to collect for you, etc. Here are a few tips:

TIP ‘& Test your system first in low volume with only one
Agenda (do not mix). It is easier to find the root cause in a
simple test, and in most cases there are issues that can be
easily found this way. For example, it is far more difficult to
find root cause when you run a mix of 20 agendas, than when
running one agenda only. Start small and grow. Only after you
are satisfied with the low volume, increase it and mix it to your
test targets.

TIP ‘& In the agile world you perform tests on the system
while it's being developed. You don't have to wait until you
have full system to start testing it. You can test performance
in your first iteration, when you have one service ready, and
move on from there to other services. You definitely do not
need to wait until the very end of your development when
performance testing at this point may be too late. With the
richness and flexibility of WebLOAD scripting you can test any
partial ready service and manipulate the test to your specific
condition.

TIP ¥ Document your tests. Performance testing

is an iterative process and you’'ll be running tests
multiple times, modifying settings and running again.
It is easy to get confused without detailed tracking of
what were the goals and exact settings each run. So
document your tests - what was running, why it was
running, what was changed from previous test, etc. It
will save you a lot of time during the triage process.

TIP ‘& Plan enough time for running performance
tests. Running tests, making changes to the
environment, fixing, re-running and analyzing results
consumes time.
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B Template B Basic Template Definition

The template definitions are built around the following

structure:
You begin execution by creating a Template in the WebLOAD
Console. The template holds the configuration details of the
test session: LG machines, schedule, scripts, etc. You can
create a template several ways:
B Using a WebLOAD Wizard - The wizard goes through all
needed options for creating a successful test session. Below the load session you first add the agendas to run
, , , , ] in the test, and for each agenda you define the Load
B Using the.GoaI-Orlented Test leard -.WhICh lets you define Generator that will run it. In the example above, there
a test while you have your target in mind. You define are two agendas defined - Registering and Searching.
the target of your test and the test will run automatically Two different load generators machines will execute
until it reaches the target. You do not need to define any each agenda.
scheduling - WebLOAD does that for you. For example, you
would like to test how many users your system will handle The wizards will create this structure as you progress
while your “register transaction” is still below 2 seconds - with your definitions. If you build your template
WebLOAD will load your system gradually and will notify manually, you should add agendas either by right
when it reaches your target. clicking the Load Session object in the tree, or by clicking
, the Agendas selection in the edit bar. The same way,
B Manually creating your template. you can add machines, schedule, change settings, etc.
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H Mix

In WebLOAD you can select several agendas and dedicate load Add agenda files to the mix, set their weight, and the
generators. But you can also define a mix of agendas to run other configurations. Once your mix is defined, save it
with a certain distribution between them, and easily define in a .mix file. From now on, you manage the mix entity
machines and schedule for all of them together rather than by and select it in your test, like any standard agenda.
one to one.

You can also add a few mix files and a few agendas in
First, define your mix by selecting the “Mix Creation” button the same test. For example, executing one mix from
from the console top edit bar. It opens the following window: a few machines, executing a second mix from other

machines, and specific agendas on yet other machines.
This powerful capability gives you the option to reach
the most enhanced agenda combination you need, with
the most enhanced configuration.

TIP '@ Read the following blogpost to learn more about
distribution of your virtual users during the test: http://
www.radview.com/how-to-distribute-stress-in-load-
testing-scenarios/.

RADVIEW)




B Template and Agenda Settings

In addition to the basic template configuration, WebLOAD
Console lets you fine tune settings, such as sleep time,
browser cache, etc. It is possible to set options for all agendas
or for specific agenda only.

Under the Tools tab, you'll find a few options:

B Global Options - Parameters that reflect basic
configuration of WebLOAD Console, and options that
affects the activity of the entire test. For example, statistics
resolution, WebLOAD DB configuration, etc.

M Default Options - These options are dedicated to the TIP ‘& Many options can be written in the JavaScript. If
agenda activity itself. The settings related to the protocols, an option appears in the script, it overrides any other
sleep time control, zip, SSL, browser cache, etc. The default option that appears in WebLOAD Console.
settings are used for each agenda that is added to your
test. TIP '@ After you define all options and before you press

B Options for the current test: the start button - check all your settings again and make

sure there are no mistakes. Load tests runs for a long
time, and you do not want to discover after a few hours
that you misconfigured something and you wasted
precious time.

> Agenda Options - When you add a mix or agenda to
WebLOAD execution tree, WebLOAD Console copies
the default options to the agenda options. So to
change any setting of one agenda, change the agenda

options. TIP ‘& By default, WebLOAD records the sleep time

> Current Sessions Options - When you make a (think time) between your clicks. You may want to run
change that will be reflected on ALL agendas that are your test with the sleep time as recorded, or you may
currently defined in your test, you can change it once want to change it dynamically during execution. In the
using the current sessions options. This is a shortcut, ‘sleep time control’ in the Agenda Options window you
instead of going over each agenda options and making can manipulate the sleep to your needs, and it will

the change one by one. overwrite the sleep time in the agenda.
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B Schedule Your Virtual Users & Agendas

Scheduling can be done in two ways:

B Manual defining virtual users and times.

B Using the load profiler which contains known profiles

like, steps, linear, random, etc. It helps you create
complex definitions easily.

‘@ Tips

Do not overload your LGs. WebLOAD console lets you
define as many virtual users as you want for a specific
machine. Note that the machine can be “weak” and
therefore cannot handle the number of virtual users
you defined. If one or more of your load generators is
overloaded during a test, the results may be worthless.
For more information, read the following the blogpost:
http://www.radview.com/blog/how-to-to-detect-
overloaded-load-generators-in-load-testing.

Make sure that the LG machines are “clean” from other

jobs and currently running processes. This can reduce the

load used power, and skew results.

You can combine profiles in your session. For example,
“step increment”, then perform “ramp up” profile, and
more.

Session tree window
@ Load Session

after]

Medify Schedule

Replace...
Delete

Copy Schedule

Paste Schedule

You can dynamically change the number of virtual
users during test execution, overriding the template’s
scheduling:

Throttle

Session
Control

You can change the number of virtual users.

Session > Freeze

You can freeze the progress of your session - you
continue testing with the current number of virtual
users and the template time does not continue.

These two features are time savers. When you want
to investigate your system’s behavior on specific load
size, you can freeze, change the load, and continue
from where you froze your test - without the need to
stop the test, and execute it again.
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B Probing Client and Real User Experience

Probing Client is a term introduced by WebLOAD and relates
to Load Generator of single client only. It is recommended to
use at least one probing client in each test for the following
reasons:

B Your LG machines are doing a lot of work simulating
many virtual users. This means that load machines may
be “noisy”. If you want to look at the response time
and transaction times, or any other timers without the
overhead of the load generator, it is recommended to see
the results from a machine that runs only a single user.
This way you can see how a single user experiences your
server performance, without the “noise”.

B A machine that runs a probing client, by definition, should
not be loaded by itself. Thus, the probing client machine
can act as a good indication whether your servers or your
LGs are overloaded. For example, you see on a certain
LG machine the response time goes up while increasing
the load. Does it mean that your server reached its max
capacity? Not necessarily. Your LG may be overloaded
(bandwidth/memory/CPU). So, take a look at the probing
client. If its response time increasing as well, it means that
your server is choking. If not - your LG.

You can also put several probing client machines in
different locations so you can see the results from
different locations. A probing client can execute any
agenda LG can execute, without any limitations.

Another interesting way to use the probing client is by
executing a real browser or mobile device. This way, you
load your servers with Load Generators, and measure
the real user experience from a browser or from a real
mobile device. WebLOAD lets you run real browsers
and devices by integrating with 3rd party functional
testing tools such as Selenium, Ranorex, Original
Software’s TestDrive, Perfecto Mobile, etc. WebLOAD
activates these tools, runs the browser activity, and
collects performance statistics from the browser or
the mobile device. This is also a great way to make
sure that your functional tests pass/fail under load. To
learn about each of the integrations, read WebLOAD
documentation.
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B Cloud Load Generators

You can Install WebLOAD LG machines on
premise and on any cloud vendor, and mix
between machines in a single test.

WebLOAD also lets you run performance test via
special integration with Amazon EC2. WebLOAD
provides a preconfigured public Amazon Machine
Image (AMI), which lets you quickly generate

load with minimal setup using your own Amazon
account. You add those cloud LGs during the

template creation - just by adding LGs from cloud.

WebLOAD automatically creates and terminates
the cloud machines for your test. Your costs are
based solely on your cloud machines activities
during the test.

To set this up access:

WebLOAD Cloud
Console > Tools > Options

The following window opens, letting you define the Amazon
machines to be used.

Cloud Accounts @

Account hame

Saturn2 Add
Detailz
i cwms

Amazon EC2 account secunity credentials. rou can find your account infarmation here

Aocezs key 1D:

Secret access kew

Advanced
Region: [us-east-'l v] hitpz: Adec? us-easzt-1. amazonaws. com
AMIID:  [vweblDAD LG | |Defaul
Type: [M1 Extia Large "]
General
Stop cloud machines when sezzion end: [Sh:up Alwaps ']

[ Apply ][ k. ]l Cancel ]’ Help ]
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B Performance Measurements Manager

On the WebLOAD Console home tab you can see the Performance Measurements Manager (PMM). Using the PMM,
WebLOAD collects server-side performance data from operating systems, web servers, application servers, database servers,
etc. This makes it possible to see client side statistics (transaction time, for example) on the same graph with server metrics
and identify the root-cause of problems.

WebLOAD PMM enables direct correlation of your load scenario with data such as CPU, memory, capacity, processes, etc.
You can quickly track down bottlenecks and pinpoint the weak links in your system.

Performance Measurements Manager Wizard il

Selecting the Measurements to Monitor
Select the checkbox for the statisticls) to monitor, and click Nexd to view a 9
summary of the selected corfiguration. i

:g Efe‘r:zry = Server side measurements are collected by WebLOAD

-@ Network Interface Console during the test, and later are displayed as
~© PhysicalDisk part of WebLOAD's results analytics reports. For more
2 Process information on the technologies WebLOAD supports,

- Processor A .
.20 see http://www.radview.com/technologies-supported.
----- [ % C1 Tirne

----- [1 % C2 Time I
----- [ % C3 Time

----- [] %DPC Time
----- [ %Idle Time TIP 9 Do not forget to collect your server

..... [ S Interrupt Time measurements during your test as it helps triage
----- [ % Privileged Time

..... % Processor Time problems faster. Otherwise, you may need to run tests
----- [ % User Time again just because you didn't configure the PMM or

""" 1 1 Transitions/sec didn't collect the right information.
----- [[] C2 Transitions/sec

----- [1 C3 Transitions/sec

----- [] DPC Rate ;I
Dezcription: % Proceszar Time is the percentage of elapsed time that the processzor zpends to il

execute a non-ldle thread. It is calculated by meazuring the percentage of time that the
processar spends_executing the idle thread and then subtracting that value from 100%. [Each j

1
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B APM Tools Integration

WebLOAD Integrates with APM (Application Performance Management) tools such as
AppDynamics, Dynatrace, and NewRelic. These tools provide deeper insight into the tested
application letting you drill down to the specific line of code associated with a performance issue.
To learn more see the WebLOAD documentation.

B Test Automation and Continuous Integration

WebLOAD's Jenkins integration enables running any performance test scenario via a regular ‘Build
Step’ in Jenkins.

You can define success/failures criteria based on many factors such as failure of the entire
session, errors and warning, validations, performance measurements, etc. This provides the
flexibility to adjust and determine how changes in performance will affect the next step in your
continuous delivery pipeline.

Automated mails provide a daily summary of build performance status, comparing results to the
previous automated builds and to a predefined baseline.
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Load Test Results Analysis

Explaining all the nuances involved in analyzing performance test results requires a dedicated book.
The following, therefore, only highlights some of the key issues. For a more in-depth discussion,
view our webinar How to Interpret Load Test Results.

B Terminology and Meanings

The diagram below illustrates the events taking place The following diagram displays the above and suggests
during each http request: reasons for an issue in each step.

B DNS lookup, which is translated to an address via
the DNS.

B A connection phase between the client and the
server.

B The client sends its request to the server.

B “Time to first byte” - represents the server
processing time and the network time. It means the
server worked when it received the entire request,
and finished when it started sending the response.
This theory is true for synchronous requests.

B The complete response is sent back to the client
and represents the network time.

RADVIEW
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http://www.radview.com/lp-how-to-interpret-load-test-results/

Load Test Results Analysis

B Timers - Response Time, Hit Time, Transactions Time

The timers are in general the first indication Do you expect hit time to change when
about your system. Of course, you should the load size is constant?
look for thresholds violations, but you may

find interesting behavior even before you
reached the violation.

Does it make sense that the time to first byte suddenly
improved significantly while the load size increased?

We can add more examples,
but you can use these
examples as a basic results
analysis that shows where
you should start looking.
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Load Test Results Analysis

B Throughput

Throughput is also a measurement that tells a lot about your servers’ behavior. For example, when throughput drops
suddenly, or when it is steady where it should grow. Take a look at the following example how throughput is affecting
response time. The system behaves perfectly at the beginning. The load size grows while the response time stays at the
same level. But then, the throughput hit a limit. Once it reaches that limit, the response time grows. The reason, in this
case was a network configuration issue that limited the capacity.

Another way to look at throughput is

your response size expectations. For each
request there is an expected response. This
is important to make sure that during the
load test you get the expected response.
Otherwise your results may mislead you.
For example, suppose you expect 1 GB

as a response. You should check that you
are getting the expected size. If you are
getting TMB it means that there is an issue.
The Response Validation helps you easily
measure the response size.
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Load Test Results Analysis

B Errors of Many Kinds B Server Measurements

We mentioned earlier in this document that you should As mentioned earlier, WebLOAD helps you collects server
validate the responses from the servers. This is a good habit, measurements via its PMM and via integration with APM
to check several types of errors that may occur during the tools. These measurements with correlation with the client
test. For example: measurement, gives you the ability to find root cause

easily. Take a look at the following example that shows

W Servererrors how memory behaves during constant load size.

B Http errors

M Validation errors - Just wrong values, or even corrupted
data

B Do not forget to look at your log files. Are errors logged
there?

To summarize, as mentioned in the

beginning of this section, there are lot of

interesting measurements and behaviors

that you should look for. We tried to

shed light on some important ones that

will help you in your triage process. ' Yy
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Analyze Your Test Results

with WebLOAD Analytics

WebLOAD Analytics lets you perform deep analysis of test results once it complete running.
WebLOAD Analytics provides many ready-made reports that contain many charts that can be used
immediately, but you can also create your own charts and reports to suit your specific needs.

On the top left panel, you can see the currently viewed report name and its charts - in this example,
“Summary Report”. You can select any chart to be viewed either from the top left panel, or by selecting
a tab on top of the Chart View.

You can select any report from the left-bottom “Gallery” panel. The Gallery panel is built from
Templates and Portfolios. A Template is a Chart definition, while a Portfolio, which is a collection of
Templates, is a Report definition. Note, that WebLOAD Analytics lets you see a full report with all its

charts, or one chart only. Just double click on a Template or Portfolio in the Gallery Panel. R/\DVIEW’
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Analyze Your Test Results with WebLOAD Analytics

B Building Templates and Portfolios

Use the “Blank Template” to build a new one. Double click and edit it via the “settings” tab
which is left of the chart view tab. Via the settings you can add measurements, zoom, change
axis, etc. While you edit the Template, you create a Chart on the fly. The new Chart is added by
default to the currently viewed report.

To save the Chart

. Save Chart
for future use select File >

as Template

You can also edit one of the predefined Charts, and save . > Save Chart
the new edited Chart as a new Template in the same way s as Template

To create new Portfolio or update a Portfolio, right click in the Gallery tree or drag and drop a
Template into a Portfolio.

TIP ‘& Note that all the changes you make are done on the currently viewed report, and do not
affect any template or portfolio, unless you save your changes.

B Publish Charts and Reports

Using WebLOAD Analytics you can create Reports to be sent to peers. Click on “Preview” button,
and then you can print it or save in several formats, such as doc, pdf, html, etc.

If you want to publish a full Report (and not a Chart only), use the “Publish Report” option from
the File menu.
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WebLOAD ControlPad

The WebLOAD ControlPad provides a single unified command and control interface where you
can create, execute, schedule, and analyze tests - all directly from your web browser, either on-
premises or in the Cloud.

Some of the tasks you can accomplish using the WebLOAD ControlPad include:

B Create and edit load tests - either based on a WebLOAD agenda or by a using single URL/API
B Upload, add and manage tests, resources, and sessions

B Execute and schedule test runs

B Analyze results using ready-made and self-configured advanced dashboards

B Share tests and results with peers

B Manage access permissions for users and groups
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WebLOAD ControlPad

B Creating and editing a Dashboard

You can easily create multiple dashboards to analyze and present different aspects of your performance testing results.
To edit a dashboard, click on its title and then click Edit.

You can add different measurements, You can add a new panel to a row and To add a new row, select the
and change the view to suit your needs. manage the rows, by hovering the 3 button at the bottom-
dots marker on top-left of each row. left of each dashboard.

= Collapse

Use the following icons on the
top to manage your dashboards.

ik

= # o
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WebLOAD ControlPad

There are several types of tests you can create in the WebLOAD ControlPad.

B URL Test

This is the most simple test you can create. Just define the the URL, virtual users, load machines,
and other parameters.

RADVIEW >
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WebLOAD ControlPad

B Agenda Test

Agenda test looks like the URL test, but instead of loading a simple URL it can use a predefined
Agenda that was created in the WebLOAD IDE. You will need to add your Agenda and any
resources your Agenda is using to the WebLOAD ControlPad Resources section.

B Template Test

Template test gives you the ability to execute a test that was created via the WebLOAD Console.

You will need to add any resources your test is using to the WebLOAD ControlPad Resources
section.

B Load Tests Management

You can execute, analyze and manage all your tests and sessions via the the Load Tests section.
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WebLOAD ControlPad

B Viewing Sessions

You can see all your sessions via the sessions view (see below) or via the Dashboards view.

You can upload sessions
that were executed by

the WebLOAD Console,

or view a session that is
currently running in the
WebLOAD Console. To do
that, WebLOAD Console
needs to be configured to
send statistics information
to the PostgreSQL DB during
runtime. See the WebLOAD
Deployment section for
details.

B Sharing a Dashboard

You can share a dashboard with your managers and peers by sending a link. You can
either share a static snapshot of your current test results, or allow the results to be
dynamically updated whenever the user receiving the link is running the dashboard.
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We hope this document will help you to get
started with WebLOAD. If you have any questions
about WebLOAD, we would love to hear from you.

Have you and your team come up with your own
WebLOAD best practices?
Share them with us!

The WebLOAD Team
prm— North American Headquarters
&P\PVIEW 991 Highway 22 West, Suite 200
. Bridgewater, NJ 08807
www.radview.com 908-526-7756

Email: sales@radview.com
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